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Inscription 
1. Veuillez suivre ces étapes pour créer un compte utilisateur Pix4D: 
2. Cliquez sur le lien ou copiez-le dans votre navigateur préféré: 

https://cloud.pix4d.com/signup/ 
3. Complétez la page d'inscription avec vos informations:

  
4. Cliquez sur ​CREATE ACCOUNT​ pour créer votre compte utilisateur. 
5. Un mail de confirmation vous sera envoyé pour activer votre compte. Ouvrez l’email et 

cliquez sur ​Confirm my email​ pour finaliser la création de votre compte. 
6. Le compte utilisateur Pix4D est maintenant créé et confirmé.  
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Activation de la licence 
Si la licence n'est pas déjà attribuée à votre compte après un e-achat, cette étape d’activation 
de la licence garantira que vous en êtes le propriétaire. Dans un premier temps, assurez-vous 
d'avoir un compte Pix4D. Si ce n’est pas le cas, veuillez créer un compte Pix4D comme décrit 
dans la partie ​Inscription​. Les étapes pour activer votre License sont les suivants :  
 

1. Cliquez sur le lien en dessous des ​Activation Instructions ​dans le ​License Certificate 
que vous avez reçu lors de l’achat de la licence. Ou suivez le lien suivant: 
https://cloud.pix4d.com/license-redeem/  

2. Entrez la clé de licence dans le champ prévu à cet effet:

 
3. Cliquez sur ​Redeem​ et la licence sera attribuée à votre compte Pix4D.  

 

Matériel - Ordinateur 
La description suivante présente les exigences matérielles et logicielles minimales et 
recommandées​: 
  
Minimum​: 

● Windows 7, 8, 10, Serveur 2008, Serveur 2012, 64 bits (Ordinateurs PC ou Mac utilisant 
Boot Camp). 

● Toute Unité Centrale (Intel i5/ i7/ Xeon recommandé). 
● Toute Unité Centrale compatible avec OpenGL 3.2. (​cartes graphiques intégrées Intel 

HD 4000 ou supérieures) 
● Petits projets (moins de 100 images à 14 MP): 4 Go de RAM, 10 Go d'espace libre sur le 

disque dur. 
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● Projets de taille moyenne (entre 100 et 500 images à 14 MP): 8 Go de RAM, 20 Go 
d'espace libre sur le disque dur. 

● Grands projets (entre 500 et 2000 images à 14 MP): 16 Go de RAM, 40 Go d'espace 
libre sur le disque dur. 

● Très gros projets (plus de 2000 images à 14 MP): 16 Go de RAM, 80 Go d'espace libre 
sur le disque dur. 

 
Recommandé​: 

● Windows 7, 8, 10 64 bits. 
● Unité Centrale 4 cœurs ou 6 cœurs Intel i7/Xeon. 
● Unité Centrale GeForce compatible avec OpenGL 3.2 et 2 GB de RAM. 
● Disque dur: SSD. 
● Petits projets (moins de 100 images à 14 MP): 8 Go de RAM, 15 Go d'espace libre sur le 

disque dur SSD. 
● Projets de taille moyenne (entre 100 et 500 images à 14 MP): 16 Go de RAM, 30 Go 

d'espace libre sur le disque dur SSD. 
● Grands projets (plus de 500 images à 14 MP): 32 Go de RAM, 60 Go d'espace libre sur 

le disque dur SSD. 
● Très grands projets (plus de 2000 images à 14 MP): 64 Go de RAM, 120 Go d'espace 

libre sur le disque dur SSD. 

Téléchargement et installation du logiciel 
À tout moment, deux versions du logiciel sont disponibles au téléchargement: 

● Pix4D Desktop: cette version est destinée au travail de production. 

● Pix4D Desktop Preview: cette version contient les fonctionnalités les plus récentes, mais n'est 
pas destinée au travail de production. 

Téléchargement 
Pour télécharger le logiciel: 

1. Rendez-vous sur:​ ​https://cloud.pix4d.com/download/​. 
2. Téléchargez Pix4D Desktop ou Pix4D Desktop Preview. 

Installation 
Une fois le logiciel téléchargé, installez-le en suivant les étapes suivantes: 

1. Double-cliquez sur le fichier téléchargé. L'assistant d'installation de Pix4Dmapper 
démarre. 
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2. (Optionnel): Si la fenêtre ​Open file - Security Warning​ apparait, cliquez sur ​Run.

 
3. Dans la fenêtre ​Pix4Dmapper Setup​, dans l’écran d’assistance de configuration 

Welcome to the Pix4Dmapper​, cliquez sur ​Next >​. 
4. (Optionnel) Cliquez sur ​Browse...​ pour modifier le chemin de destination de l'installation 

puis cliquez sur ​Next >​. 
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5. Cliquez sur ​Install​. 

 
6. (Optionnel) Dans la fenêtre d'informations sur le logiciel: "​Do you want to allow the 

following program to install software on this computer?​" autrement dit "​Voulez-vous 
autoriser le programme suivant à installer des logiciels sur cet ordinateur?"​, cliquez sur 
Yes​. 

7. Puis cliquez sur ​Finish​. 
8. Un raccourci est créé sur votre bureau et le logiciel s'ouvre automatiquement une fois 

l'installation terminée. 
9. Lors du premier démarrage du logiciel, la fenêtre ​Pix4Ddesktop Login​ apparait: 
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10. Entrez votre ​Email ​et le ​Password ​de votre compte et cliquez sur ​Login​.  
11. Lisez le ​End-User License Agreement​, sélectionnez ​I accept the terms in the License 

Agreement​ et cliquez sur ​Next​. 
12. Sélectionnez une des options suivantes: 

a. Request Pix4Dmapper now (Free Trial)​ pour activer une version d’essai de 15 
jours. 

b. Use Pix4Ddiscovery​ pour activer la version limitée. 
c. Choose a license​ ​pour sélectionner parmi les licences existantes sur le compte. 

13. Cliquez sur ​OK​. 
  
Pix4D Desktop est maintenant prêt pour le traitement. 

Paramètres de langues 
Vous pouvez modifier les paramètres de langue sur Pix4D Desktop à tout moment: 

1. Démarrez Pix4Dmapper. 
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2. Dans la barre de menu, cliquez sur ​Help > Settings… 

 
3. La fenêtre des paramètres ​Settings ​s’ouvre: 

 
4. Cliquez sur l’onglet ​Language​. 
5. En dessous la section ​Select the User Interface Language​, sélectionnez votre langue. 
6. Cliquez sur ​OK​. 

Les changements seront pris en compte au redémarrage du logiciel. 

Mise à jour 
Les versions les plus récentes de Pix4D Desktop et de Pix4D Desktop Preview sont toujours 
disponibles au téléchargement, comme décrit dans la section ​Téléchargement. 
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De plus, si une nouvelle version de Pix4D Desktop est disponible, une fenêtre contextuelle de 
mise à jour logiciel avec trois options s'affiche lorsque le logiciel est ouvert : 

1. Choisissez​ Download and Install Now​ pour télécharger et installer la dernière version 
disponible. 

2. Choisissez​ Remind Me Later​ pour ne pas télécharger ou installer la dernière version. La 
fenêtre apparaîtra à nouveau dans 10 jours. 

3. Cliquez sur​ Cancel​ pour ne pas télécharger ou installer la dernière version. Aucun 
rappel n'apparaîtra. 

 

Désactivation de la licence 
À partir de la version 4.0, une nouvelle gestion des licences a été mise en place, permettant de 
désactiver à distance un appareil: 

1. Cliquez sur​ Log out​ pour vous déconnecter à partir du logiciel Pix4D Desktop. 
2. Accédez à votre tableau​ License Management​: 

https://cloud.pix4d.com/account/licenses​ . 
3. Sous votre licence Pix4Dmapper, cliquez sur ​Enable now ​pour activer votre licence: 

 
4. Connectez-vous au logiciel Pix4D Desktop via​ Log in​. Cela enregistrera 

automatiquement l'appareil sur la page Licences. 
 

5. Pour désactiver l’appareil, accédez à la page ​https://cloud.pix4d.com/account/licenses​ et 

cliquez sur ​Deactivate . 
 

Fichiers d’entrés 
Les fichiers d’entrés principaux de Pix4Dmapper sont des images qui peuvent être aux formats 
.JPEG ou .TIFF. 

Avertissement​: ne modifiez pas les images, c'est-à-dire n’éditez pas ou ne pivotez pas les 
photos. La modification des images altère les propriétés géométriques de la caméra et peut 
détériorer la qualité des résultats. 

Format Description 

.jpg, .jpeg Images JPEG 
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.tif, .tiff TIFF Monochrome 

TIFF Multi-bandes (RVB / Infrarouge / thermique) 

1 couche (pas de pyramide, pas de multipage) 

8, 10, 12, 14, 16 bits entiers, virgule flottante 

Fichiers de sorties 
Pix4Dmapper peut générer ces fichiers de sorties:  
 

● Paramètres​ de la caméra​ (​Paramètres Internes​, ​Paramètres​ Externes​, ​Bingo​, ​SSK​): Ces 
fichiers décrivent les paramètres internes (taille de focale, ...) ou externes (position et 
orientation) de la caméra et des images. 

● Images non déformées 
● Nuage de points densifié ​(​.las, .laz, .xyz, .ply​)​: C'est un ensemble de points 3D qui 

constituent le modèle. La position X, Y, Z et les informations de couleur sont stockées 
pour chaque point du nuage de points densifié. 

● Modèle Numérique de Surface ​(​Grid M​NS, ​Raster MNS​)​: C'est un modèle 2.5 D de la 
zone cartographiée qui contient des informations (X, Y, Z) mais pas d'informations de 
couleur. 

● Modèle Numérique Terrain​ ​(​M​NT: ​Raster M​NT​): ​C'est un modèle 2.5 D de la zone 
cartographiée issu de l’élimination de l’ensemble des objets ne représentant pas la 
surface du terrain naturel tels que les bâtiments, la végétation, qui contient des 
informations (X, Y, Z) mais pas d'informations de couleur. 

● Orthomosaïque​ (​GeoTIFF​, ​Fichier KML​, ​Fichier Google Maps HTML​): ​Modèle 2D (carte) 
réalisé en mélangeant plusieurs orthophotos. Correction radiométrique (couleur 
équilibrée) pour être visuellement agréable. 

● Carte d’Index​ (​GeoTIFF​, ​Fichier KML colorisé​, ​Grid Shapefile​): ​Pour chaque indice est 
associé une carte d'index. Pour chaque pixel de cette carte, la valeur du pixel est 
dérivée des cartes de réflectance associées. 

● Mesh​ 3D Texturé ​(​.obj, .fbx, .dxf, .ply, .pdf, .osgb, .slpk​): C’est une représentation de la 
forme du modèle composée des sommets, des arêtes, des faces et de la texture des 
images qui sont drapées dessus. Ce format est utile pour présenter et visualiser le 
modèle, mais également pour le partager et le télécharger sur des plateformes en ligne 
telles que Sketchfab. 

● Lignes de contour​ (​shp, .pdf, .dxf​)​: Ces lignes relient des points d'élévation égale. Ils 
sont utiles car ils permettent de mieux comprendre la forme de la surface terrestre (la 
topographie) sur une carte. 

● Animations Vidéo​ ​(​.mp4, .mkv, .avi​)  
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● Objets Numériques 3D: Polyligne, Surface, Surface​ de base d’un volume​ ​(​.shp, .dxf,.kml, 
.don​) 

Plan d'acquisition d'images 
Le plan d'acquisition d'images dépend du: 

● Type de ​terrain / ​de l’​objet​ à reconstruire.  
● Ground Sampling Distance (GSD)​: Le GSD requis par les spécifications du projet 

définira la distance (hauteur de vol) à laquelle les images doivent être prises. Par 
exemple, un GSD de 5 cm signifie qu'un pixel dans l'image représente linéairement 5 cm 
sur le sol (5 * 5 = 25 centimètres carrés).  

● Chevauchement des images​: Le chevauchement dépend du type de terrain 
cartographié et déterminera la vitesse à laquelle les images doivent être prises. 

 
Un mauvais plan d'acquisition d'images conduira à des résultats inexacts ou à des échecs de 
traitement et nécessitera l'acquisition d'images à nouveau. 
 
Tous ​les plans de vol​ décrits ci-dessous peuvent être pilotés automatiquement depuis 
l'application de planification de vol ​Pix4Dcapture​ disponible sur Android et iOS. 

Cas général 
Dans la plupart des cas, il est recommandé d'acquérir les images avec un ​quadrillage régulier​. 
Le chevauchement recommandé est d'au moins ​75% de recouvrement longitudinal​ (par 
rapport à la direction du vol) et d'au moins ​60% de recouvrement latéral​ (entre les trajectoires 
du vol). La caméra doit être maintenue autant que possible à une ​hauteur constante 
au-dessus du terrain / de l'objet pour assurer le GSD désiré. 
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Le recouvrement et la hauteur de vol doivent être ​adaptés en fonction du terrain​. 
 
Pour les forêts, les zones de végétation dense et les terrains plats avec des champs agricoles, il 
est recommandé d'augmenter le recouvrement longitudinal à au moins 85% et le recouvrement 
latéral à au moins 70% ainsi que de voler plus haut afin de détecter plus aisément les 
similitudes. Les projets comportant des images thermiques nécessitent au moins 90% de 
recouvrement longitudinal et latéral. 

Pour les projets avec ​plusieurs vols​, il doit y avoir un chevauchement entre les différents vols 
et les conditions (direction du soleil, conditions météorologiques, pas de nouveaux bâtiments, 
etc.) doivent être similaires. 

Reconstruction de bâtiment 
Pour la reconstruction d'un bâtiment, un plan de vol ​circulaire​ est recommandé. 
● Volez autour du bâtiment une première fois avec un angle de caméra de 45°. 
● Volez une deuxième et une troisième fois autour du bâtiment en augmentant la hauteur de vol 
et en diminuant l'angle de la caméra à chaque tour. 
● Il est recommandé de prendre une image tous les 5 à 10 degrés pour assurer un 
chevauchement suffisant, en fonction de la taille de l'objet et de la distance qui le sépare. Plus 
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d'images doivent être prises pour des distances plus courtes et des objets plus grands.

 
Remarque: La hauteur de vol ne doit pas être augmentée plus de deux fois entre tous les vols, 
car des hauteurs différentes conduisent à des GSD différents. 

Reconstruction Urbaine – visibilité des façades 
La reconstruction 3D des zones urbaines nécessite un plan d'acquisition d'image en croisé, de 
sorte que toutes les façades des bâtiments (nord, ouest, sud, est) soient visibles sur les images. 
Le recouvrement devrait être le même que dans la section ​Cas Général​.  
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Pour que les façades soient visibles, les images doivent être prises avec un angle compris en  
10° et 35°. 

 

Modèles d’options de traitement 
Ce sont les ​Modèles d'Options de Traitement​ par défaut disponibles dans Pix4Dmapper. Nous 
vous recommandons fortement de les utiliser pour traiter vos projets. 
 

Modèles d’Options de 
Traitement 

Description 

Cartes 3D Fichiers de sorties​: carte 3D (nuage de points, Mesh 3D texturé) 
ainsi qu'un MNS et une Orthomosaïque. 
Fichiers d’entrées typiques​: images aériennes acquises à l'aide 
d'un plan de vol croisé. 
Qualité / fiabilité des fichiers de sorties​: élevée. 
Vitesse de traitement​: lente. 
Applications​: carrières, cadastre, etc. 

Modèles​ 3D Fichiers de sorties​: Modèle 3D (nuage de points, Mesh 3D 
texturé). 
Fichiers d’entrées typiques​: images aériennes obliques ou 
terrestres avec un fort recouvrement. 
Qualité / fiabilité des fichiers de sorties​: élevée. 
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Vitesse de traitement​: lente. 
Application​: Modèles 3D de bâtiments, d'objets, d'images au sol, 
d'images d'intérieur, d'inspection, etc. 

Agriculture Multi 
spectral​e 

Fichiers de sorties​: réflectance, indice (tel que NDVI), cartes de 
classification et d'application. 
Fichiers d’entrées typiques​: images nadir aériennes de caméras 
multi spectrales (Sequoia, Micasense RedEdge, Multispec 4C, 
etc.). 
Qualité / fiabilité des fichiers de sorties​: élevée. 
Vitesse de traitement​: lente. 
Application​: agriculture de précision. 

Agriculture Caméra 
modifiée 

Fichiers de sorties​: réflectance, indice (tel que NDVI), cartes de 
classification et d'application. 
Fichiers d’entrées typiques​: images nadir aériennes de caméras 
RVB modifiées. 
Qualité / fiabilité des fichiers de sorties​: élevée. 
Vitesse de traitement​: lente. 
Application​: agriculture de précision. 

Agriculture RVB Fichiers de sorties​: Orthomosaïque. 
Fichiers d’entrées typiques​: images de caméras RVB pour 
l'agriculture (Sequoia RVB). 
Qualité / fiabilité des fichiers de sorties​: élevée. 
Vitesse de traitement​: moyenne. 
Application​: reconnaissance numérique, rapport pour l'agriculture 
de précision. 

Cartes 3D – Rapide / 
Rés​olution basse 

Un traitement plus rapide de ​cartes 3D​ pour évaluer la qualité de 
l'ensemble de données acquises. 
Qualité / fiabilité des fichiers de sorties​: basse. 
Vitesse de traitement​: rapide. 

Modèles 3D – Rapide / 
Rés​olution basse 

Un traitement plus rapide de ​modèles 3D​ pour évaluer la qualité 
de l'ensemble de données acquises. 
Qualité / fiabilité des fichiers de sorties​: basse. 
Vitesse de traitement​: rapide. 
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Agriculture Caméra 
modifiée - Rapide / 
Rés​olution basse 

Un traitement plus rapide des modèles ​agriculture caméra 
modifiée ​pour évaluer la qualité de l'ensemble de données 
acquises. 
Qualité / fiabilité des fichiers de sorties​: basse. 
Vitesse de traitement​: rapide. 

Agriculture RVB – 
Rapide / Rés​olution 
basse 

Un traitement plus rapide des modèles ​agriculture RVB ​pour 
évaluer la qualité de l'ensemble de données acquises. 
Qualité / fiabilité des fichiers de sorties​: basse. 
Vitesse de traitement​: rapide. 

Caméra​ Thermique Fichiers de sorties​: carte de réflectance thermique. 
Fichiers d’entrées typiques​: caméras thermiques (Tels que 
capteurs Tau 2, FLIR Vue Pro, FLIR XT). 
Qualité / fiabilité des fichiers de sorties​: élevée. 
Vitesse de traitement​: lente. 
Application​: contrôle de l'irrigation, panneaux solaires, inspection 
du bâtiment, etc. 

Caméra ThermoMAP Fichiers de sorties​: carte de réflectance thermique. 
Fichiers d’entrées typiques​: images nadir aériennes de la 
caméra ThermoMAP. 
Qualité / fiabilité des fichiers de sorties​: élevée. 
Vitesse de traitement​: lente. 

 

Comment créer un projet 
Cette partie va pas à pas à travers le processus de création d'un nouveau projet. Des exemples 
de jeux d'images peuvent être téléchargés depuis ​Pix4D Knowledge Base​. 

Créer un Nouveau Projet 
Pour créer un nouveau projet: 

1. Démarrez Pix4Dmapper. 
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2. Dans la barre Menu, cliquez ​Project > New Project...
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3. La fenêtre Nouveau Projet s’ouvre:

 
4. Dans ​Name:​ inscrivez le nom de votre projet. 
5. (optionnel) Dans ​Create in​: cliquez sur ​Browse...​ Puis dans l’assistant ​Select Project 

Location​, naviguez puis sélectionnez le dossier où vous souhaitez stoker le projet et ses 
résultats puis cliquez sur ​Select Folder​.  

Remarque:​ Assurez-vous des points suivants: 

● Le nom du projet n'utilise PAS de caractère spécial. 
● Le chemin où le projet est créé n'utilise PAS de caractère spécial. 
● Le nom du projet et le chemin contiennent ensemble moins de 128 caractères. 

 
6. (optionnel) Cochez la case ​Use As Default Project ​pour enregistrer tous les nouveaux 

projets dans le dossier sélectionné. 
7. Dans ​Project Type, ​gardez par défaut l’option ​New Project​ sélectionnée. 
8. Cliquez sur ​Next​. 
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Importez les images 
Dans la fenêtre ​Select Images​: 

1. Cliquez sur ​Add Images...​ pour ajouter des images​.

 
2. Dans l’assistant ​Select Images​, naviguez pour choisir le dossier contenant les images, 

sélectionnez les images à importer (vous pouvez en sélectionner plusieurs), puis cliquez 
sur ​Open​. 

3. Enfin, cliquez sur ​Next​. 

Configuration des propriétés de l'image 
Il y a trois étapes optionnelles à suivre avant de cliquer sur ​Next​: 
 
a​. ​(optionnel) ​Sélectionner le système de coordonnées de l'image  
Si la géolocalisation de l'image est donnée dans un système de coordonnées autre que WGS84 
(par défaut), cliquez sur ​Edit​ ...dans​ Coordinate System​, et sélectionnez le système de 
coordonnées de vos images. 
 
b​.​ ​(optionnel, recommandé) Importer la géolocalisation et l'orientation de l'image 
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Si les informations de géolocalisation d'image (position) sont stockées dans l'EXIF des images, 
elles seront automatiquement chargées. Note: les informations de géolocalisation peuvent 
également être importées depuis un fichier, en cliquant sur ​From File​ .... 
Remarque: 

● Le logiciel prend en compte le champ ​Date​ de l'EXIF pour configurer l'ordre dans lequel 
les images sont prises. 

● Étape 1. Le traitement initial est plus rapide pour les projets avec géolocalisation 
d'images. En cas de recouvrement insuffisant, la géolocalisation de l'image permet de 
calibrer les images  

c​. ​(optionnel) ​Modifier le modèle de la caméra sélectionné 
Un modèle d’appareil photo doit être défini pour exécuter un projet dans Pix4Dmapper. Les 
paramètres de ce modèle dépendent de la caméra utilisée pour capturer l'image. La plupart des 
caméras enregistrent leur nom dans les métadonnées de l'image au format EXIF. Ce champ est 
utilisé pour associer un modèle de capteur donné à toutes les images prises avec cette caméra. 
La section ​Selected Camera Model​, dans la fenêtre ​Image Properties​, ​affiche le modèle de 
caméra sélectionné. Le modèle du capteur peut être: 

 ​Valid​: ​Une coche verte s'affiche si le modèle de caméra est valide. Un 
modèle de caméra est valide s'il existe déjà dans la base de données du modèle 
de caméra de Pix4Dmapper ou si les données EXIF des images contiennent 
suffisamment d'informations pour créer un nouveau modèle de caméra qui sera 
enregistré dans la base de données du modèle de caméra utilisateur. Si le 
modèle de caméra est extrait des données EXIF, il est recommandé de vérifier 
les paramètres du modèle de caméra et, si nécessaire, de les modifier. 

 ​Invalid​: ​Une croix rouge est affichée si le modèle de caméra n'est pas 
valide. Un modèle de caméra n'est pas valide s'il ne figure pas dans la base de 
données du modèle de caméra de Pix4Dmapper et s'il n'y a pas suffisamment 
d'informations dans les données EXIF des images. Dans ce cas, le modèle de 
caméra doit être défini manuellement. 

 
 

Sélection du système de coordonnées GCP 
Dans la fenêtre Select Output Coordinate System: 

1. (optionnel) Changez le ​Output / GCP Coordinate System​. 

Remarque:  

● Par défaut, le système de coordonnées de sortie et les GCP seront les mêmes. Ainsi, 
les fichiers de sorties peuvent être affichées dans le système de coordonnées des GCP. 

● Par défaut, l'unité est affichée en m (mètres). 
● Si les images ont une géolocalisation, par défaut l’option Auto Detected est sélectionné, 

affichant la zone UTM ou NAD83 correspondante des images. 
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● Si les images n'ont pas de géolocalisation, Arbitrary Coordinate System est sélectionné 
par défaut. 

 
2. Cliquez sur ​Next​. 
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Sélection du modèle d'options de traitement 

Dans la fenêtre ​Processing Options Template​: 
1. Sélectionnez le modèle désiré en fonction de l’application et des résultats souhaités 

décrits dans la section ​Modèles d’Options de Traitement​.

 
2. (optionnel) Cochez la case ​Start Processing Now​ ​pour commencer automatiquement le 

traitement. 
3. Cliquez sur ​Finish ​pour fermer la fenêtre d’assistance et commencer le traitement. 
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Étapes de traitement 

Cette section décrit les trois étapes du traitement avec Pix4Dmapper. 

1. Traitement initial 
Dans cette étape, les images et les fichiers d’entrés supplémentaires tels que les GCP décrits 
dans la section ​Fichiers d’entrés​ ​seront utilisées pour effectuer les tâches suivantes:  
 

● Extraction des points caractéristique​: identifie les fonctions spécifiques comme les 
points caractéristique dans chacune des images. 

● Correspondance des points caractéristique: ​permet de rechercher les images ayant 
les mêmes points caractéristique et de les faire correspondre ensemble. 

● Optimisation du modèle de caméra: ​permet de calibrer les paramètres internes 
(distance focale, ...) et externes (orientation, ...) de la caméra. 

● Géolocalisation GPS / GCP: ​permet de localiser le modèle si des informations de 
géolocalisation sont fournies. 
 

Des points d'attaches automatiques sont créés au cours de cette étape. Ces points sont la base 
pour les prochaines étapes de traitement. 
 
Pour plus d'informations sur les fichiers de sorties, voir la section ​Fichiers de sorties​. 

2. Nuage de points et Maillage 3D 
Cette étape va se servir des points d'attache automatiques pour: 

● La Densification de points​: des points d'attache supplémentaires sont créés en 
fonction des points d'attache automatiques, ce qui créé un nuage de points densifié. 

● Maillage 3D Texturé​: basé sur le nuage de points densifiés, un maillage texturé 3D peut 
être créé. 

3. MNS, Orthomosaïque et Indice 
Cette étape permet la création de:  

● Modèle Numérique de Surface (DSM)​: La création du MNS permettra de calculer des 
Volumes, des Orthomosaïques et des Cartes de Réflectance. 

● Orthomosaïque​: La création de l’Orthomosaïque est basée sur l'ortho-rectification. 
Cette méthode supprime les distorsions de perspective des images. 

● Carte de Réflectance​: Le but est de produire une carte où la valeur de chaque pixel 
indique fidèlement la réflectance de l'objet. 
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● Carte d’Indices​: Générer une carte d'indices où la couleur de chaque pixel est calculée 
en utilisant une formule qui combine différentes bandes de la carte ou des cartes de 
réflectance. 

Points de contrôle au sol (GCPs) 
Cette méthode est utilisée lorsque ​la géolocalisation d'image et les GCP sont dans un 
système de coordonnées connu​ qui peut être sélectionné à partir de la base de données du 
système de coordonnées de Pix4Dmapper. Les deux systèmes n'ont pas besoin d'être 
identiques comme Pix4Dmapper est capable de faire la conversion entre deux systèmes de 
coordonnées connus. 
 
Ceci est ​LE CAS LE PLUS COMMUN​ et permet de marquer les GCP sur les images avec peu 
d'intervention manuelle. Cependant, cette méthode n'est pas adaptée au traitement dit "de nuit" 
au cours duquel les différentes étapes de traitement démarrent automatiquement d'affilée, ne 
nécessitant aucune supervision de la part de l'utilisateur. 

Instructions 
1. Obtenir des mesures de GCP sur le terrain ou par d'autres sources.  
2. Ajouter / importer les GCP avec le gestionnaire ​GCP / MTP Manager​ ​SANS ​les 

marquer​. 
3. Dans la barre du Menu, cliquez sur ​View > Processing​. La barre de ​traitement​ apparaît 

au bas de la fenêtre principale. 
4. Sélectionnez ​1. Initial Processing et désélectionnez ​ ​2. Point Cloud and Mesh ​et ​3. DSM, 

Orthomosaic and Index​. 
5. Cliquez sur ​Start​.

 
6. Une fois le ​Initial Processing​ terminé, marquez les ​GCPs​ dans la section ​rayCloud​. Dans 

la barre latérale gauche, dans la section ​Layers​, cliquez sur ​Tie Points​, puis 
sélectionnez ​GCPs / MTPs​. La liste des GCPs s’affiche. Sélectionnez un GCP dans la 
section ​GCPs / MTPs​: la barre latérale droite affiche alors ses propriétés et la liste des 
images dans lesquelles le GCP est visible. Marquez la position exacte du GCP sur au 
moins 2 images en utilisant le clic gauche de la souris. Lorsque la croix verte est à la 
bonne position dans la plupart des images, cliquez sur ​Apply​. 

7. Cliquez sur ​Process > Reoptimize​. 
8. (optionnel) Régénérez le rapport de qualité en cliquant sur ​Process > Generate Quality 

Report​. 
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